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SULEIL Functionalities index

SYNCHROTRON

« Environment variables

« Preferences settings
—  Scan server device settings
— Data fitter device settings
— Historic log settings
—  Data recording settings
— Enable confirmation settings
—  Scan server device properties settings
—  Nexus file browser integration

« Salsa mode
—  Configuration mode
—  Configuration manager (New !)
—  Scan result
—  Salsa read only
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SULEIL Functionalities index

SYNCHROTRON

« Create a new configuration

 (General parameters « Scan execution
—  Number of scan -  Start
— Actuators delay —  Abort
—  Zig zag trajectory — Pause
— Scan on the fly — Resume

— Scan speed adjustement
—  After run function and scan function

« Scan parameters
— Sensors
— Time bases
— Actuators
— Trajectories
— Hooks
—  Error strategies

Salsa Manual User 4



SWLEIL
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Functionalities index

« Scan result

Current scan historic
1D result

2D result

Display manager
Error strategies
Scans historic

 QOthers

Perspectives

Data fitter

Data recorder
Bookmarks

Search tool

Record data service
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SULEIL Software architecture

SYNCHROTRON

Python Passerelle acteur V3

ds_SimpleScan

SalsaDB
SalsaAPI 7

Start|Configuration ds DataFitter
fittedDataArray
startRecording ds_ScanServer /F'tdt o
it data_

actuators, sensors, trajectory
data_01,data_02...

Hooks, ScanFunctions
ds_DataRecorder Start,Abort,Pause,Resume
V2
NeXus files
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COMETE graphical library

Librairie graphique COMETE

Dataitem: SIC240B_186_Holo_tiScientaidatal

Showas @ image ) spectrums 7 spectum stack ClearData

140 173 210 243 25 315 350 3 40 [ 430 525 560 3 =] 565

Toom: 150% axes: fout]

Data item: SiC240B_186_Holo_1/Scientaidatal

Show as ) image (@ spectrums

() spectrum stack [Clear Data

9000

7500 |

6000 |

W

Wl

SiC240B_186_Holo_1/Scienta/datal_11 (Y1)
SiC240B_186_Holo_1/Scienta/datal_12 (Y1)
SiC240B_186_Holo_ 1!8c|enb3}daba1 235[Y1)

SiC240B_186_Holo_1/Scientaidatal_10 (Y1)
SiC240B_186_Holo_1/Scienta/datal_231 (¥1)
SiC240B_186_Holo HScwema.idatal 234 [Yl)

iPRARR 486 Uale 4 _iCnAND 408 Ll

SiC240B_186_Holo_1/Scienta/datal_13 (Y1) :
SiC240B_186_Holo_1/Scienta/datal_230 (Y1
SIC240B_186_Holo_ IfSclenizdeia1 139 [Y1—

e oirnAnR 486 Ul

4] I}

B

Freeze Values

Clear Freezes

- Visible data views : |SiC 240B_186_Holo_1/Scienta/datal_0

- Hidden data views : |

AAAL AL

+030.00

B 1 S A

NEXUS

TANGO

Archivage
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SULEIL Software architecture

SYNCHROTRON

DataRecorderBean CurrentScanResultBean DataFitterBean
m‘ (=] I Scan Resur » — x| [r-ox] [ew ol

Q View
' SPECTRUM | IMAGE i

Dat

e, @ s B
[Fresse vamea| [Ciear Freazes) it St o] auson
- el — e

Sttty

™ = _ox T2 g =
e Run Name: [OUBTESTBNDEES Scan number: [ [ Fnparamenrs
it | o

P et

i
H
i
i
!]i:

COMETE Graphical library

ds_DataFitter
fittedDataArray
ds_ScanServer /

actuators, sensors, trajectory
data_01,data_02...

Hooks, ScanFunctions
ds_DataRecorder Start,Abort,Pause,Resume

\%

Fichiers NeXus
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ULEIL Software architecture

SYNCHROTRON

532.4.2-SNAPSHOT (2012-06-
File Edit Window Perspective Help

save || Data recorder OFF | [> start i |

+ scan Manager # — x

Hew <& Delete

isplay Mang 4 » 5 2 _ O %

S = =

Mame Label A
.[tangontangote...|x

o
root

SalsaAPI i e o N

44 HosTest
@ KTest ]
4 TEst1DDefault
4> TestiDoK -2
L2 BTEST2 =
4> 1DFast
4 aconng
4 BConfig

g g
tangoftangote
tangoftangote
tangoftangote
tangoftangote
tangoftangote
sensortimes

roject Directory:

ub Directory:

HEEEE

SalsaDB

Y T

¥

70
tangoftangotestititanishort_scalar_w

= = = tangoitangotestiitaniiong_scalar (¥1) === Fitted Data X (¥1)

tangonangotestintanssnort_scaiar_w NONGEEENE | | sen |
[———— e —

Mot initialised

Axis selection : |¥1 |+

[J General | © Timen gl 03] Sensors | 45 Actuators X | Wk Trajectory X | 47 Hooks # — x [T Error Strategies | His | ‘clog | [EE=r)
o5 ¥ Fam] |
icaisalsalscan.1 un start date Scan end date Run remaining time Scan remaining time De: 1 time Scan completion
2012 Jun07 470343 00:00-00 00:00.00

| Data Recorder # — x| [r-ox] i
L Data Fiting. 5 [ ] |
CONTACQ [:} RunName: [GOEETESTENDEES Scan Humber: ==

[ view data into player 0] functca

1= Scen Resut 7 = x|

= SrecTim L | . " o ot 0 SRS

i T oo

— - e
Terhivacal Dafa b .
e

e o
— . | Y=
= o) o

20

e T e e ,
a— RO

Clear Freezes Determnation Guasty Factor B %
———————————————— e =
L tangonangotesttanishort_scater_w [NNNNGNNRN = o0 |_sens | i

rctn
= sangonsngossmaniros [N =500 | sens m‘h_| 0 —— ‘

Details | History | Admin Sena an P - [=]
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Software packages

PASSERELLE_ROOT

Bossanova

Passerelle

SalsaAPI (Duplication)

LIVE ROOT

SALSA

DataRecorderBean

ScanResultBean

DataFitterBean

Comete

SalsaAPI

DEVICE_ROOT

ds_DataRecorder

ds_ScanServer

ds_DataFitter
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SULEIL Salsa lexicon

SYNCHROTRON

TANGO : The control system of SOLEIL

Device : A TANGO programme for remoting a equipement or
processing.

Attribute : An equipment or a process parameter (eg : position or
integration time).

Command : A equipement or a process action (eg : Move or Count)

Scan server device : TheTango device server for processing scan.

Nexus : Format of files of SOLEIL.

Sensor : listened Tango parameter

Actuator : moved Tango parameter

Hook : A simple Tango command (no argument as Start, Close...)

Perspective : A custom view disposition.
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SULEIL Environment variables

SYNCHROTRON

Salsa needs for several environment variables to be set.
« TANGO HOST
Host of the tango database (localhost:20001)

SALSA_SERVER_URL
Url of the salsa database (jdbc:mysql://localhost/salsa)

« SALSA_LOGIN
The login of the user connected on Salsa database

« SALSA_PERSPECTIVES_DIRECTORY
The folder for the perspectives files

« SALSA_DEVICE_PREFERENCES
The file for the device configurations

« SALSA_UI_PREFERENCES
The file for the user interface configurations
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SULEIL Salsa Preferences settings

SYNCHROTRON

— Log file setting

— Scan server device setting

— Data Fitter device setting

— Nexus file browser application

File | Edit| Window |" Preferences

el Rl Bean Preferences
—| Copy - Display Your choice
« | Paste Ctrl-V/ Enable confirmation false
* Bean —
— Preference Plaver wizsitble falze
Image monachrome falze
Data browser clatahrowser
Devices Cantral Pgnel atkpanel .
dzer LogFile JusrfLocalfcanfigFiles fsalsafscanlog

Devices Preferences

Salsa Model Choose Device
Scan3erver icalsalsalscan.
_ DrataFitter icalsalsafit.1

Salsa Manual User 13



SOLEIL
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Salsa Mode

Configuration mode : (“salsa” command)

In this mode you can create, modify and remove a scan configuration.
All the configuration edition views are available in the Menu

Window > Show View > Configuration Views

2 AConfig - Salsa S{project.version} (${buildNumber])
File Edit |[Window | Perspective Help

Q’ Nd @ Reset Layout ctl-T
Show View }| Result Views

*
Scan
2 Scan Manager # — X * ] Timebase Sensors & — xI PoOx
Ei General
/°| || =) H | = New |vH Delete H up || Down | [] CheckiUncheck all
& Actuators X
l:l = CCon sy Trajectory X |v| [tangoitangotesttitan/double_scalal otestititan/double_scalar
@ Timebase [v] [tangoitangotestititan/short_scalar A4 Aih
™ Hooks [v] [tangotangatestiiiwave _ +0.000 - Control Panel
[v] [tangoitangotestititan/double_ima T
ﬁ Error = g g = 1 =
1& AConfig C ion Manager
1& DConfig ‘. Bookmarks i Actuators X o Trajectory X & — X 2-0Ox
* EnergyOnTheFly
1& MultiSensorScan
% NewScan ‘ Range 1 ‘ ‘ Range 2 ‘
Scan1D
& F—— Integration Time: 1.0 Integration Time 1.0
can imesean Number of Steps 1 Number of Steps 10
ik Tesscank Acqusiion time 10 Acquisiton time 100
4 TestiDz0393
1& TestiDOK [] Custom trajectory [] Custom trajectory ;
o Test2p =
‘& TestEnergy2 fsngaitangatestititan/smeli FRll);\'ID | TD‘E 5 | FREI\; | TD‘ = |
A Testscan2DAcluor
4 Timescan [] Relative A 100|0 | Relative A 100
o= [ Release_3_4 1 =]
- Release_3_5_0
- Re\ease:3:5:4 [] Onthe fly []Enable actuator speed control
- ann
[ 4 General | §® Hooks B Error strategies # x| a_Dx
Sensors actuators [~
Time Out[5.0 s Time Out5.0 |s
Retry Counl‘i \ Retry Co||||||5 |
Time Relnes‘u 2 \ s | Time Belween Relnes|U.2 |5
strateay|PAUSE ] Strategy|ABORT [~ |
timebases hooks
Time Out[5.0 s Time Out[5.0 |s
Retry Counl‘ﬁ \ Retry Co||||||5 |
Time Relnes‘u 2 \ s  Time Belween RelneslU.Z |5
Strateay IGNORE -~ Strategy|PAUSE [~]
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SULEIL Salsa Mode

SYNCHROTRON

Configuration manager (New !)
The management of several configurations is possible now.

You can Add, Remove, Enable/Disable a TimeBase, Sensor or Actuator on several
configurations.

Select several configuration in the Scan Manager Tree.
The devices appear in red color, are the uncommon devices.

9 AConfig - Salsa ${project.version] (${buildNumber})
File Edit Window Perspective Help

‘ w(_‘fNew H »q_)gne\ete ‘éSave ‘ [> H H ‘n

¥ Scan Manager # — x| 2 Confi . =
» [ Configuration manager ¢ xl O x
|:| List r@ Timebases r Sensors r * ActuatorX |

| + iste

root [] Check alllUncheck all | New |V | | Add selected to all | | Remove selected from all

o~ [B5 ATESt
o [J BTEST2 Enable Device | Not connected
¢ (B Katy &

1 Aconfig
1b DConfig
‘& EnergyOnTheFly
4 MuttisensorSean

1b NewScan

1b Scan1D

& Scan2DTimeScan
& TEsScank

4D TestiD20203

4 TestiDOK

4 Test2D

& TestEnergy2

4 TestsCan2DActuor

1b TimeScan
o Release_3_4_ 1
o Release_3_ 5 0
o [B3 Release_3_5_4
o~ [ Yann

tango/tangotesttitan/ampli A iiaaoaa
tangoftangotestiitan/short_scalar_w 4] — +000.00 —
" € ITIFTTIT
tangotestifampli
ampli
o/opimotor.a/position
tango/tangotest//ampli

E|EIEIEIs)E
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Salsa Mode

Salsa read only: (“salsa_ro” command)

In this mode you can only select a Scan configuration from the bookmark, modify the
scan configuration (delete or add devices, or hook is not possible).

And you can play the configuration.

# Salsa S{projectversion} (§{buildNumber}) read only

e =

root/Katy/AConfig

N - G
b Trajectories | % Actuators | [ Sensors | | Timebases [Gragy/ror Strategies | |4 General | & Hook |

[E=S =R =

Range 1

Integration Time 1.0
Humber of Steps 1

Acquisition time 1.0

Range 2

Integration Time 1.0
Nurmber of Steps. 10

Acquisttion time 100

[] Custom trajectory

[] Custom trajectory

FROM TO

FROM 10
[5.0

tangoitangotestititan/ampli
5.0 | |

5.0 | 50 ]

[] Relative A 100/

[] Relative A 1.0/

[_] Custom trajectory

FROM TO

[_] Custom trajectory

FROM TO

tangoitangotestititan/short_scalar_w

[150.0 | |20 |

[o.0 | [oo |

[ClRelative 4] 1280[[]

[IRelative 4| 0.0/ []

[] Custom trajectory

[] Custom trajectory

angotesti/smpli FROM T FROM T0
tang o 10.0 | [z00 | [0.0 | oo ]

ClRelaive 4] 100/[]

CIRelative 4| 0.0/ []

[_] Custom trajectory

[_] Custom trajectory

FROM TO

FROM 10
[eo

smpli o] |

[o.0 | oo ]

[_] Relative A 8.0/

[_] Relative A 0.0/ ]

(] On the fly [] Enable actuator speed control

ica/salsa/scan.1 - Run start date Scan start date Run remaining time  Scan remaining time Dead time Scan completion
‘SeanSorar i oy fora W eei Cal  E0T3DEcAZH00I4E  E0TDECH2 100348 ] ] N |

Scan number :

Scan result
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SULEIL Salsa Mode

Salsa result : (“salsa_result” command)

In this mode you can only visualize the current scan result.
All the views for the visualization are available in the Menu :
Window > Show View > Result Views

# Salsa S{projectversion} (${buildNumber})
File Edit | Window | Help
Show View b| Result Views ¥| L= Scan Result
[ " 1T ™" T) I scan Historic
Display Manager
L~ Scan Result & — % Scan Functions Display Manager # - X | Scan Functions |
Historic Log
e Name Label Ais
SPECTRUM | IMAGE Data Fitter actuator_1_1 position__|Y1 -
SOETE - - - : - - - - - actuator_1_2 position
1
gata_01 uble._
15E12 1/sensorstime.
10E12
50E11
0 05 1 15 2 25 3 35 4 45
Index
pe
actuator imestamps (Y1) —=— borisitestimotor 2/position (Y1) ~
icalsalsalfit1
Freeze Values| Clear Freezes|
sntetetmt 2t OOOUU | | mrosniing |
Sigmal
TS D _ ] Not initialised
Send all Axis selection : Dﬂ
Historic Log # - % | [£] Scan Historic |
Date v Action Name Nexus NxEntry Trajectory 2
short_scalar_wfrom 150.010 2.0 delta 128 |+
2013-12-04 09:49.49 [> [sconti data_00ST76 100945 _rool_Katy_AGanfig_00001 | i 10 2010 6.0 delta 0.8
g onfig ata_ s experiment ool Kaly_AConfig short_scalar_w from 0.0 1o 0.0 delta 0.0 |
amplifrom 0010 0.0 delta 0.0
20131128 0924 14 []_|rootKaty AConfig
short_scalar_w flom 150,010 22.0 delta 12.8
amplifrom 2.0 10 -6.0 delta 0.3
2013-11-28 08:24.12 [> |aconfig data_00520.nxs experiment_00920_root_Katy_AConfig_00007 |gp ot ceaiar w fram 0,010 0.0 delta 0.0
amplifrom 0.010 0.0 delta 0.0 I~
icalsalsalscan.1 - Run start date Scanstartdate  Run remaining time  Scan remaining time Dead time Scan completion Scan number:
SeanSoneris ooy foranow s CAl | 20130ec 2100348 B01Dec12 100345 soones w000 N | [
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Create a new configuration

* New scan configuration. It exist several kind of

SCan
+ Scan Manager » —KI r=DOx|
Rl H =|
sl =
root

¢ [E[aTESt |

4 2DTESTNew
4b Aaconiig

1b AConfig

1b BConfig

1b CConfig

@y HosTest

‘& KTest

4D TEst1DDefault

4D TestiDOK -2
o [ BTEST2
o- [ Katy
0~ Release_3_4 1

1D = dimension X

2D = dimension X et dimension Y

HCS = 1D continu hardware with a time base
K = 1D specific trajectory in 3 phases

E = 1D trajectory visualed differently in a table

File Edit Wind

Or right click on the tree to make appears the

configuration management menu.

Click on the New button

E root
¢ B ATESt

0~ ‘r’ann

2 2DTES

New Directory

Ctrl-R

4 2acon

4 Aconfi

“fn New 1D
4% New 2D

Crl-M
Ctrl-E
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SULEIL General parameters
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— LIGNE/EX/SCAN.1/scanNumber —
— LIGNE/EX/SCAN.1/ actuatorsDelay

— LIGNE/EX/SCAN.1/ zigzag

— LIGNE/EX/SCAN.1/ onTheFly

— LIGNE/EX/SCAN.1/ enableScanSpeed
— LIGNE/EX/SCAN.1/ afterRunActionType

<_/

__scanserver
attributes

QGEHEW =X @ Timebase ||E| Sensors | 1 Trajectory X, Actuators X |J':9 Hooks | ﬂ Error Strd 1A rpwFr_0x

ScanNumber |1 | Actuator delay |EI.EI

[ ] zigzag
[ ] on the fly

[_| enable actuator speed

Post Scan Behaviour

No operation hd

Mothing to do
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Scan parameters

LIGNE/EX/SCAN.1/sensors
LIGNE/EX/SCAN.1/timebases ___ Scanserver
LIGNE/EX/SCAN.1/actuators attributes

LIGNE/EX/SCAN.1/trajectories

Predefined values defined in the device properties :
 ActuatorskFile,
« SensorsFile,
 TimebaseskFile

r Device properties [ICA/SALSAISCAN.1]
Froperty name Yalue

| ActuatarsFile

menu:TangoTest Titan:null
submenu:;:ampli:tangotangotestititan/ampli
submenu:short_scalar_w:tangoftangotestititan/short_scalar_w

| SensorsFile

menu:TangoTest Titan:null

submenu:;double_scalar:tangotangotestititan/double_scalar @' GE"EFﬂ[ [;D Timehﬂgg I 4

submenu:short_scalar:tangoitangotestititan/short_scalar

ml

| SynchronizeData

| TimebasesFile

false r
menu::Simulated Counter:null H&W“] Delete I LHD ‘ Down

submenu:MIGE0Z testiniGG02/simuled

Simulated Counter ¢ HIGG02
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SULEIL Hooks configuration

SYNCHROTRON

—

— LIGNE/EX/SCAN.1/postActuatorMoveHooks
— LIGNE/EX/SCAN.1/postintegrationHooks
— LIGNE/EX/SCAN.1/postRunHooks

— Scanserver

— LIGNE/EX/SCAN.1/postScanHooks attributes
— LIGNE/EX/SCAN.1/postStepHooks
ﬁ Hooks & - X E
L] Pre Run b A &
Pre Run [ | Command name |LIGNENIOBX/Open

Pre 5can

Pre Step

Post Actuator Move
Post Integration
Post Step

Post Scan

Post Run

Salsa Manual User
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SOLEIL

SYNCHROTRON

Error strategy

— LIGNE/EX/SCAN.1/sensorsErrorStrategy
— LIGNE/EX/SCAN.1/sensorsRetryCount
— LIGNE/EX/SCAN.1/contextValidation

—

4_/

] E Error Strategies # — x[

scanserver
—

attributes

Sensors

Time Out|5.0

Retry Cou nt|5

Time Between Retries|0.2

Strateg]r| IGNORE

timebases

Time Out|5.0

Retry Count|5

Time Between Retries|0.2

Strateg]r| IGNORE

context validation

actuators

Time Out|5.0

Retry Coun1|5

Time Between Retries|0.2

Strategyr|FGHORE

hooks

Time Out|5.0

Retry Count|5

Time Between Retries|0.2

51rategy| IGNORE

Attribute |

Strategy |tGHc:-RE

Salsa Manual User
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SYNCHROTRON

Scan actions

« Executed by the user on demand (except in Abort case) !

— LIGNE/EX/SCAN.1/afterRunActionType

— LIGNE/EX/SCAN.1/afterRunActionSensor
— LIGNE/EX/SCAN.1/afterRunActionActuator

— LIGNE/EX/SCAN.1/afterRunActionActuatorVValue

— Commande LIGNE/EX/SCAN.1/ExecuteAction

| Scan Functions #

Action type
Sensor

Actuator

- X

No operation

Mo operation
Scan 1st position

|Before scan

Sensor max
Sensor min

Max of derivative
Min of derivative
Center of mass

Scan Functions @ = X

Action type
Sensor

Actuator

+—

scanserver
___ attributes

Sensor max

tango/tangotestititan/double_scalar |+

Go to

jGn to the maximum position of a sensaor

Salsa Manual User
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SOLEIL

SYNCHROTRON

Scan historic

« Current scan historic (can be very useful for debugging !)

—  LIGNE/EX/SCAN.1/historic

| ] sean Historic & - x|

scanserver attribute

2a.Ox

Period -

Typoe

Message

2012-06-08T13:56:

le 689831

IMFO

FEun ended successfully

2012-06-08T13:56:

1e E9E08

IMFO

Executing sensors after_run...

[ » [ “

2012-06-08T13:56:

le 6B9647

IMFO

Executing after-run action...

2012-06-08T12:56:

16582441

IMFO

DataRecorder : EndRecording

d012-06-08T12:56:

16 5E928E

DEBUG

wynchronisation with data recording. .

2012-06-08T12:56:

16589244

DEBUG

Fermaining scan to oo ;0

2012-06-08T13:56:

16588128

IMFO

DaraRecorder | Endrhxentny

2012-06-08T13:56:

16536178

IMFO

DataFecorder ; WriteMonitoredData

2012-06-08T13:56:

16 3278655

IMFO

DataFecorder ; WritePostTechnicalData i e

2012-06-08T13:56:

16 378625

DEBUG

iteilo

Access to DataRecorder file has been released. .

2012-06-08T13:56:

16 277368

DEBUG

Dpening Mxentry swing_00%8_scan_TabhlTz1

2012-06-08T13:56:

16 276781

DEBUG

Opening file fusrflocal/spool/datarecarder/2 0110796 freglages f=swi. ..

2012-06-08T13:56:

16 27E7EE

DEBUG

Access granted to DataRecarder file. ..

2012-06-08T13:56:

16 275894

DEBUG

Feguesting access to DataRecarder file...

2012-06-08T13:56:

16 275687

DEBUG

Access to DataRecorder file has been released. ..

2012-06-08T13:56:

1&. 174340

DEBUG

[41, 1] Writing step walues 1o Mexus file

2012-06-08T13:56:

1. 174323

DEBUG

Mxdata 'scan_data' opened

2012-06-08T13:56:

1e.174151

DEBUG

Dpening Mxentry swing_Q058_scan_TablTzl

d012-06-08T12:56:

16 172567

DEBUC

Opening file fusrfLocalfspool/datarecorder/ 20110796,/ reglagesjowi. ..

2012-06-08T12:56:

16 172550

DEBUG

Access granted to DataRecorder file.

2012-06-08T12:56;

16172280

DEBUG

Feguesting access to DataRecorder file.

2012-06-08T12:56:

16172241

DEBUG

[ 41, 1]5aving value of i11-c-cOS/ot/mi_diode. 3fintensity

2012-06-08T13:56:

16172214

DEBUG

[41, 1]5awing walue of ill-c-co=/difmi_diode Safintensity

2012-06-08T13:56:

16172150

DEBUG

synchronisation with data recording. .

2012-06-08T13:56:

16171445

DEBUG

Sensor read [ ill-c-cosfdifmi_diode. 3/fintensity

l

Clear
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SULEIL
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Scan 1D result visualization

— Send the actuator to the selected point.

L~ Scan Result # - | Data Recorder | Data Fitter |

F_OX

[ SPECTRUM | IMAGE |

1 .
0 5 10
tango/tangotestititan/short_scalar_w

I~

FS

—=— tango/tangotesttitan/ampli (¥ 1)
tango/tangaotesttitan/double_scalar (Y2}

—=— Fitted Data X (Y'])

Freeze Values

tangoltangotestititan/ampli _ -20.0)
tangoitangotestititan/short_scalar_w _ 10. | Send

Display Manager # — X | Scan Functions | [ | Scan Historic |

LIGNE/EX/SCAN.1/data_XX scanserver attribute

[¢—Dx

Name Label Axis
actuator_1_1 tangoitangotesttitanfampli Y1 bt
actuator_1_2 tangoitangotesttitan/short_scalar_w X
data_01 tangoitangotesttitanidouble_scalar Y2
sensorsTimestamps sensortimestamps

icalsalsalfit.1

X ical/salsalscan.1/actuator_1_1 |+
Y |
icalsalsalscan.1/data_01 hd
Sigma
Notinitialised |

Axis selection :

Salsa Manual User
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SULEIL Scan 2D result visualization

SYNCHROTRON

— LIGNE/EX/SCAN.1/data_XX scanserver attribute
— Send the actuator to the selected point.

L Scan Result # — X | pata Fitter | Data Recorder | L

Run Name : _ Scan Number : .

[ ] View data into player

SPECTRUM | IMAGE |

150

tango!tangotesmitanrampli_|5.I:I || Send | tangortangotesmitanrshort_scalar_w_|E.I:I || Send ‘ | Send line

Send all
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SULEIL Scan 2D in N spectrums

SYNCHROTRON

* Display a 2D Image in N Spectrum in Chart
— LIGNE/EX/SCAN.1/data_XX scanserver attribute

Run Name : _ Scan Number : .

[] View data into player

[ SPECTRUM | IMAGE

40 T T T T T T T T T
30 | |
20l i
10 -
% 25 50 75 00 125 180 175 200 725 Z50
tango/tangotestititan/short_scalar w
-
tango/tangotesttitan/double_image_ro_0 (Y 1) =]
tango/tangotestititan/double_image_ro_1 (Y 1)
tango/tangotestititan/double_image_ro_2 (¥ 1)
—=— tango/tangotestititan/double_image_ro_3 (Y1)
tango/tangotestititan/double_image_ro_4 (Y1)
tango/tangotestititan/double_image _ro 5 (¥ 1)
tango/tangotesttitan/double_image_ro_6 (Y1)
—=— tango/tangotestititan/double_image_ro_7 (Y1)
—=— tango/tangotestftitan/double_image_ro_8 (Y1)
tango/tangotestititan/double_image_ro_9 (¥ 1) -
tango/tanactesttitan/double image ro 10 Y1) it
Freeze Values Clear Freezes

e e e B e e L R R Lo Ce e M b iy
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SYNCHROTRON

SULEIL Salsa historic log

« Scans executed actions via SalsaAPI historic (historic file)
— ds_simpleScan, passerelle and Salsa.
— Replay (exactly) a scan via Play button

— Click on the nexus file name to open it a nexus file browser application
| Historic Log & — x| [roox

Date = Action Mame Mexus Trajectory =
short_scalar_w from -3.0 to 10.0 delta 2.6
ampli from 30.0 to 25.0 delta 1.0

short_scalar_w from 15.0 to 22.0 delta
2012-06-08 11:29:45 D 1DFast itmp/dataicontacg/contacg-soleillcontacqi2012/0323it0to_2012-06-08_09-37-19_0p 4375

ampli from 20.0 to 12.0 delta 0.5

| ftmp/dataicontacg/contacg-soleilicontacg/2012/032 3itoto_2012-06-08_09-37-19_0309.nxs |
short_scalar_w from-3.0to 10.0 delta 2.6
ampli fram 30.0 to 25.0 delta 1.0
short_scalar_w from 15.0 to 22.0 delta
2012-06-07 17:03:21 [> 1DFast itmp/dataicontacg/contacg-goleilicontacg/2012/0323itoto_2012-06-07_14-12-10_0p 4375 |
ampli from 20.0 to 12.0 delta 0.5

short_scalar_w from 30.0to 20.0 delta
N 939939372993229373994

2012-06-07 14:12:28 [] |rootBTESTZ2 1DFast ltmp/data/contacg/contacg-soleil/contacg/2012/0323toto_2012-06-07_14-12-10_0

short_scalar_w from-3.0 to 10.0 delta 2.6
ampli from 30.0 to 25.0 delta 1.0
short_scalar_w from 15.0to 22.0 delta
2012-06-07 141217 [> 1DFast itmp/datalcontacg/contacg-soleilicontacg/2012/0323ioto_2012-06-07_14-12-10_0g 4375

ampli from 20.0 to 12.0 delta 0.5

short_scalar_w from 20.0 to 20.0 delta
N 83739333933393334

2012-06-07 14:12:09 [ ] |rooctBTESTZ 1DFast itmpi/data/contacqg/contacg-soleilfcontacq/2012/0322/0to_2012-06-07_14-11-57_0

short_scalar_w from-3.0 to 10.0 delta 2.6
ampli from 30.0 to 25.0 delta 1.0
short_scalar_w from 15.0 to 22.0 delta
2012-06-07 14:11:56 D 1DFast itmp/dataicontacg/contacg-soleilfcontacqi2012/0322t0to_2012-06-07_14-11-57_0p 4375

ampli from 20.0 to 12.0 delta 0.5

short_scalar_w from 30.0 to 20.0 delta
Ne8337333333373733334

2012-06-07 10:07:05 [ ] |rootBTEST2.1DFast ytmp/data/contacg/contacg-soleilfcontacg/2012/0322it0to_2012-06-07_10-08-53_0)

short_scalar_w from-3.0 to 10.0 delta 2.6
ampli from 30.0 to 25.0 delta 1.0
short_scalar_w from 15.0 to 22.0 delta - |

Refresh || Clear || Print |
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SULEIL

SYNCHROTRON

Salsa functionalities

* Perspectives

| DConfig - Salea 3.4.1 (2012-04-16 18:39:38)
File Edit Window | Perspective

5 /e | Help
© Default
Hew % Delete i o
© Scan

4 Scan Manager

® MyPerspective

|

Q AConfig
ﬁ DConfig

(& TEsScank
.

New Cri+Maj-h
Remove Cirl+Maj R
Lo B
root
o [E9 ATEst
- [[ BTEST2
¢ B xay

-

| %] Scan Result

L ScanResult ¢ x

SPECTRUM | IMAGE

play Manager # XI
Name Label Axis
actuator_1_1 tangoftangotestiitan/ampli Y1
actuator_1_2 tangoftar t_scalar_w X
data_01 tango/ftangotesttitan/double_scalar Y2
sensorsTimestamps sensortimestamps
¢ O0x |
calsalsalfit.1

X ica/salsa/scan.1/actuator_1_1 | v
L]
icalsalsa/scan.1/data_01 -
Sigm
Mot initialised

Axis selection :

Aw

15 20 25

tango/tangolesttitan/short_scalar_w

B sensors # = x | i Trajectory X, Actuators X | Historic Log |

o] |

tangoitangotest/titan/ampli (Y1)
—=— langoftangotest/titan/double_scalar (Y2}

—= Fitted Data X (Y1)

vl | esthitan/double_scalar]
vl |1angurtangmeswlam’duuble_spe i

Freeze Values)

g

Clear Freezes,

tango/tangotestititaniampli _ -8.0

v o [N - n [ cona

scalar

aiany

HEHHOONETR +0.000 RUNNING

FToTE

4]

ica/salsaiscan.1

v |

Run start date Scan end date

Run remaining time  Scan remaining time

Dead time

Scan completion
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SULEIL Data Fitter bean

SYNCHROTRON

« DataFitter integration in the scan chart result

— LIGNE/EX/FIT . 1/fittedData¥Y
— LIGNE/EX/FIT.1/deviceAttributeNameX
— LIGNE/EX/FIT.1/deviceAttributeNameY

Scanserver
>— .
attributes

<«
L Scan Result # — X | Data Recorder | Data Fitter | # — O x| | Display Manager # — X | Scan Functions |[| ScanHistoric | [ #_DOx
SPECTRUM [ IMAGE | Ll bt o
l/ actuator_1_1 tangoitangotestititan/ampli Y1 i
o actuator_1_2 tangoitangotesttitanishort_scalar_w b
data_01 tangoitangotestititan/double_scalar Y2
180 e e e | ||||sensOrS Timestamps  |sensor timestamps
1-75
75|
4 -150
oF
4 -225
.75L
0 5 10 15 20 25 200 1]
tango/tangotestiitan/short_scalar w -
a icalsalsalfit.1
—=— tango/tangotestititan/ampli (Y1} —= Fitted Data X (¥1)
—=— tango/tangotestiitan/double_scalar (Y2} X licalsalsa/scan.1/actuator_1_1 |+
-t
icalsalsa/scan.1/data_01 -
Freeze values|
e e T e T T b L T T L L L L e e e e S T e T L e T T ‘ smma
tangol/tangotestititan/ampli _ -20.0 : Mot initialised
tangoltangotestititanishort_scalar_w _ 100 | Send — Aol okttt

Salsa Manual User



SULEIL Display a Stack of spectrum

* Display a stack of spectrum in a player
+ Video files generation

 LIGNE/EX/SCAN.1/data XX scanserver attribute

}~" Scan Result ﬁ_xl

.0

Run Name : _ Scan Number : .

B> v 10 ms [> £ B
C} !Generate a animated file {.gif, .avi ar .moﬂL
| | | | | | | |
0 1 2 3 4 5 [ T

View data into player

[ SPECTRUM | IMAGE |

1 1 1 1 1 1 1 1
0 0.2 0.4 0.6 0.8 1 1.2 1.4 18 18 2 22 24 26 28 3 iz 34
Index

1 1 ]
16 a8 4

W

tango/tangotestititanfong_scalar 0 (Y1)

Freeze Values Clear Freezes
g L A L B T D L D S A A LA LM M AR
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SULEIL Display a Stack of image

SYNCHROTRON

* Display several images as a image player
+ Video files generation
— LIGNE/EX/SCAN.1/data_XX scanserver afttribute

L~ Scan Result 6...):' d_Ox
RunName: [OOUBIESIZADEasSt Scan Number: [l
Ll J[ o | ow [[some |[BL]] = [[&8 |[ B ]
| Play | l;!
| | 1 |
[i} 1 2 3
View data into player
[ SPECTRUM [ IMAGE |
l/Pjayer |
ol 50 1001] 150 201] 250 o
30
a0
25
100
20
150 15
10
200
5
250
o
data_05
Zoom: 100% axes: [out]
T P R R R o T R R P g A A o e g R R T A P g e A i Tt e e e A T g P R A R A T A T R A R e A S A A A
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SULEIL Bookmars

SYNCHROTRON

— Bookmarks creation

+ Scan Manager » — X PO
P = & B
W o+ - | |Favori1 * (2D | >
ok Favorii
o [ ATEst Favori2
o~ [B§ BTEST2
o- [ Katy
o= Felease 3 4 1
o= Yann
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SULEIL Salsa Searching tool

SYNCHROTRON

& Scan Manager # — X d_DOx
e = KTe LS 53
Wl o+ - | [Favori1 | |2D |-

roat

¢ B ATEst
4 2DTESTNew
ﬁ AACanfig
ﬁ AConfig

ﬁ BConfig
4 cconig

{4 HCaTest

ﬁ% KTest

4 TEst1DDefault

4 TestiDOK -2

o~ [B BTESTZ

o- [ Katy

o= Felease 3 4 1
o= Yann
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SULEIL Data recorder activation

SYNCHROTRON

« Disable of data recording
LIGNE/EX/SCAN.1/recordData scanserver attribute

|£| Preferences |£| @

Devices Preferences
Salsa Model Choose Device

icalsalsalscan.

. SCansernver
3N | DataFitter icalsalsaffit 1
£, | DataRecorder false

[QQ Salsa 3.4.2-5NAPSHOT (2012-06-08 15:41:36)
File Edit Window Perspective Help

o s RGO

| £,| Salsa 3.4.2-SNAPSHOT (2012-06-08 15:41:36)
File Edit Window Perspective Help

New & Delete ¥ save

Data recorder OFF
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SOLEIL

SYNCHROTRON

Salsa open Nexus files

* Open a nexus file in the databrowser

Click on a nexus file name to open it in the databrowser.

Historic Log # — X

2 _Ox

Date =

Action

MName

MNexus

Trajectory

%

2012-06-08 11:29:45

1DFast

ltmp/data/contaco/contacg-soleilfcontacg/2012/0323itoto_2012-06-08_09-37-19_0

short_scalar_w from-3.0 to 10.0 delta 2.6
ampli from 30.0 to 25.0 delta 1.0
short_scalar_w from 15.0to 22.0 delta
0.4375

ampli fram 20.0 to 12.0 delta 0.5

| ftmp/datalcontacg/contacg-soleil/contacg/2012/032 3itoto_2012-06-08_09-37-19_0309 nxs |

2012-06-07 17:03:21

1DFast

ltmp/data/contacg/contacg-soleillcontacg/2012/0323itoto_2012-06-07_14-12-10_0

short_scalar_w from-3.0 to 10.0 delta 2.6
ampli from 30.0 to 25.0 delta 1.0
short_scalar_w from 15.0to 22.0 delta
0.4375

ampli from 20.0 to 12.0 delta 0.5

short_scalar_w from 20.0to 20.0 delta
N28337333337333733374

2012-06-07 14:12:28

root BTEST2.1DFast

ltmp/data/contacg/contacg-soleilfcontacg/2012/0323itoto_2012-06-07_14-12-10_0

2012-06-07 141217

1DFast

itmp/data/contacg/contacg-soleil/contacg/2012/03230to_2012-06-07_14-12-10_0

short_scalar_w from-3.0to 10.0 delta 2.6
ampli fram 30.0 to 25.0 delta 1.0
short_scalar_w from 15.0to 22.0 delta
0.4375

ampli from 20.0 to 12.0 delta 0.5

short_scalar_w from 30.0to 20.0 delta
N 9399393722392 993994

2012-06-07 14.12:09

root BTEST2.1DFast

ltmp/data/contacg/contacg-soleil’contacg/2012/0322itoto_2012-06-07_14-11-57_0

2012-06-07 14:11:56

1DFast

ltmp/datal/contacg/contacg-soleilfcontacg/2012/0322itoto_2012-06-07_14-11-57_0

short_scalar_w from -3.0 to 10.0 delta 2.6
ampli from 30.0 to 25.0 delta 1.0
short_scalar_w from 15.0to 22.0 delta
0.4375

ampli from 20.0 to 12.0 delta 0.5

short_scalar_w from 30.0 to 20.0 delta
N 2833323332323323732372734

2012-06-07 10:07:05 [] |rootBTESTZ.1DFast itmp/data/contacg/contacg-soleilfcontacg/2012/0322itoto_2012-06-07_10-06-53_0
short_scalar_w from -3.0 to 10.0 delta 2.6
ampli from 30.0 to 25.0 delta 1.0
P short_scalar_w from 15.0 to 22.0 delta =

e e
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